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Turn project into package,  
Enable roxygen documentation with 
 Tools > Project Options > Build Tools

Roxygen guide at  
Help > Roxygen Quick Reference

File > New Project >  
New Directory > R Package

Share Project 
with Collaborators

Active shared 
collaborators

Select  
R Version

Start new R Session 
in current  project 

Close R 
Session in 
project 

JHT

RStudio saves the call history, 
workspace, and working 
directory associated with a 
project. It reloads each when 
you re-open a project. 

Name of 
current project

View(<data>) opens spreadsheet like view of data set

Sort by 
values

Filter rows by value 
or value range

Search 
for value

Viewer Pane displays HTML content, such as Shiny apps, 
RMarkdown reports, and interactive visualizations

Stop Shiny 
app

Publish to shinyapps.io, 
rpubs, RSConnect, …

Refresh 

RStudio opens documentation in a dedicated Help pane

Home page of 
helpful links 

Search within 
help file

Search for 
help file

GUI Package manager lists every installed package

Click to load package with 
library(). Unclick to detach 
package with detach()

Delete 
from 
library

Install 
Packages

Update 
Packages

Create reproducible package 
library for your project

RStudio opens plots in a dedicated Plots pane

Navigate 
recent plots

Open in 
window

Export 
plot

Delete 
plot

Delete 
all plots

Package 
version 
installed

Examine variables 
in executing 
environment

Open with debug(), browser(), or a breakpoint. RStudio will open the 
debugger mode when it encounters a breakpoint while executing code.

Open traceback to examine 
the functions that R called 
before the error occurred

Launch debugger 
mode from origin 
of error

Click next to 
line number to 
add/remove a 
breakpoint.

Select function 
in traceback to 
debug

Highlighted 
line shows 
where 
execution has 
paused

Run commands in 
environment where 
execution has paused

Step through 
code one line 
at a time

Step into and 
out of functions 
to run

Resume 
execution

Quit debug 
mode

Open Shiny, R Markdown, 
knitr, Sweave, LaTeX, .Rd files 
and more in Source Pane

Check 
spelling

Render 
output

Choose 
output 
format

Choose 
output 
location

Insert 
code 
chunk

Jump to 
previous 
chunk

Jump 
to next 
chunk

Run 
selected 
lines

Publish 
to server

Show file 
outline

Set knitr 
chunk 
options

Run this and 
all previous 
code chunks

Run this 
code chunk

Jump to 
chunk

RStudio recognizes that files named app.R, 
server.R, ui.R, and global.R belong to a shiny app

Run 
app

Choose 
location to 
view app

Publish to 
shinyapps.io 
or server

Manage 
publish 
accounts

Access markdown guide at  
Help > Markdown Quick Reference

Stage 
files:

Show file 
diff

Commit 
staged files

Push/Pull  
to remote

View 
History

current 
branch

• Added 
• Deleted 
• Modified 
• Renamed 
• Untracked

Turn on at Tools > Project Options > Git/SVN

Open shell to 
type commands

A

D

M

R

?

Search inside 
environment

Syntax highlighting based 
on your file's extension

Code diagnostics that appear in the margin. 
Hover over diagnostic symbols for details.

Tab completion to finish 
function names, file paths, 
arguments, and more.

Multi-language code 
snippets to quickly use 
common blocks of code.

Open in new 
window

Save Find and 
replace

Compile as 
notebook

Run 
selected 
code

Re-run 
previous code

Source with or 
without Echo

Show file 
outline

Jump to function in file Change file type

Navigate 
tabs

A File browser keyed to your working directory. 
Click on file or directory name to open.

Path to displayed directory

Upload 
file 

Create 
folder

Delete 
file 

Rename 
file 

Change  
directory

Displays saved objects by 
type with short description

View function 
source code

View in data 
viewer

Load 
workspace

Save 
workspace

Import data 
with wizard

Delete all 
saved objects

Display objects 
as list or grid

Choose environment to display from 
list of parent environments

History of past 
commands to 
run/copy

Display .RPres slideshows 
File > New  File >  
R Presentation

Working 
Directory

Maximize, 
minimize panes
Drag pane 
boundaries

JHT

Cursors of 
shared users

File > New Project

Press ! to see 
command history

Multiple cursors/column selection 
with Alt + mouse drag.

Documents and Apps R Support

PROJECT SYSTEM

Debug Mode Version Control with Git or SVN

Package Writing
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3 NAVIGATE CODE Windows /Linux Mac
Goto File/Function Ctrl+. Ctrl+.
Fold Selected Alt+L Cmd+Option+L
Unfold Selected Shift+Alt+L Cmd+Shift+Option+L
Fold All Alt+O Cmd+Option+O
Unfold All Shift+Alt+O Cmd+Shift+Option+O
Go to line Shift+Alt+G Cmd+Shift+Option+G
Jump to Shift+Alt+J Cmd+Shift+Option+J
Switch to tab Ctrl+Shift+. Ctrl+Shift+.
Previous tab Ctrl+F11 Ctrl+F11
Next tab Ctrl+F12 Ctrl+F12
First tab Ctrl+Shift+F11 Ctrl+Shift+F11
Last tab Ctrl+Shift+F12 Ctrl+Shift+F12
Navigate back Ctrl+F9 Cmd+F9
Navigate forward Ctrl+F10 Cmd+F10
Jump to Brace Ctrl+P Ctrl+P
Select within Braces Ctrl+Shift+Alt+E Ctrl+Shift+Option+E
Use Selection for Find Ctrl+F3 Cmd+E
Find in Files Ctrl+Shift+F Cmd+Shift+F
Find Next Win: F3, Linux: Ctrl+G Cmd+G
Find Previous W: Shift+F3, L: 

Ctrl+Shift+G
Cmd+Shift+G

Jump to Word Ctrl+ "/# Option+ "/#
Jump to Start/End Ctrl+!/$ Cmd+!/$
Toggle Outline Ctrl+Shift+O Cmd+Shift+O

8 DOCUMENTS AND APPS Windows/Linux Mac
Preview HTML (Markdown, etc.) Ctrl+Shift+K Cmd+Shift+K
Knit Document (knitr) Ctrl+Shift+K Cmd+Shift+K
Compile Notebook Ctrl+Shift+K Cmd+Shift+K
Compile PDF (TeX and Sweave) Ctrl+Shift+K Cmd+Shift+K
Insert chunk (Sweave and Knitr) Ctrl+Alt+I Cmd+Option+I
Insert code section Ctrl+Shift+R Cmd+Shift+R
Re-run previous region Ctrl+Shift+P Cmd+Shift+P
Run current document Ctrl+Alt+R Cmd+Option+R
Run from start to current line Ctrl+Alt+B Cmd+Option+B
Run the current code section Ctrl+Alt+T Cmd+Option+T
Run previous Sweave/Rmd code Ctrl+Alt+P Cmd+Option+P
Run the current chunk Ctrl+Alt+C Cmd+Option+C
Run the next chunk Ctrl+Alt+N Cmd+Option+N
Sync Editor & PDF Preview Ctrl+F8 Cmd+F8

7 MAKE PACKAGES Windows/Linux Mac
Build and Reload Ctrl+Shift+B Cmd+Shift+B
Load All (devtools) Ctrl+Shift+L Cmd+Shift+L
Test Package (Desktop) Ctrl+Shift+T Cmd+Shift+T
Test Package (Web) Ctrl+Alt+F7 Cmd+Opt+F7
Check Package Ctrl+Shift+E Cmd+Shift+E
Document Package Ctrl+Shift+D Cmd+Shift+D

6 VERSION CONTROL Windows/Linux Mac
Show diff Ctrl+Alt+D Ctrl+Option+D
Commit changes Ctrl+Alt+M Ctrl+Option+M
Scroll diff view Ctrl+!/$ Ctrl+!/$
Stage/Unstage (Git) Spacebar Spacebar
Stage/Unstage and move to next Enter Enter

5 DEBUG CODE Windows/Linux Mac
Toggle Breakpoint Shift+F9 Shift+F9
Execute Next Line F10 F10
Step Into Function Shift+F4 Shift+F4
Finish Function/Loop Shift+F6 Shift+F6
Continue Shift+F5 Shift+F5
Stop Debugging Shift+F8 Shift+F8

2 RUN CODE Windows/Linux Mac
Search command history Ctrl+! Cmd+!
Navigate command history !/$ !/$
Move cursor to start of line Home Cmd+"
Move cursor to end of line End Cmd+ #
Change working directory Ctrl+Shift+H Ctrl+Shift+H
Interrupt current command Esc Esc
Clear console Ctrl+L Ctrl+L
Quit Session (desktop only) Ctrl+Q Cmd+Q
Restart R Session Ctrl+Shift+F10 Cmd+Shift+F10
Run current line/selection Ctrl+Enter Cmd+Enter
Run current (retain cursor) Alt+Enter Option+Enter
Run from current to end Ctrl+Alt+E Cmd+Option+E
Run the current function 
definition

Ctrl+Alt+F Cmd+Option+F
Source a file Ctrl+Alt+G Cmd+Option+G
Source the current file Ctrl+Shift+S Cmd+Shift+S
Source with echo Ctrl+Shift+Enter Cmd+Shift+Enter

1 LAYOUT Windows/Linux Mac
Move focus to Source Editor Ctrl+1 Ctrl+1
Move focus to Console Ctrl+2 Ctrl+2
Move focus to Help Ctrl+3 Ctrl+3
Show History Ctrl+4 Ctrl+4
Show Files Ctrl+5 Ctrl+5
Show Plots Ctrl+6 Ctrl+6
Show Packages Ctrl+7 Ctrl+7
Show Environment Ctrl+8 Ctrl+8
Show Git/SVN Ctrl+9 Ctrl+9
Show Build Ctrl+0 Ctrl+0
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Previous plot Ctrl+Alt+F11 Cmd+Option+F11
Next plot Ctrl+Alt+F12 Cmd+Option+F12
Show Keyboard Shortcuts Alt+Shift+K Option+Shift+K

RSP extends the  the open source server with a 
commercial license, support, and more:

• open and run multiple R sessions at once 
• tune your resources to improve performance 
• edit the same project at the same time as others 
• see what you and others are doing on your server 
• switch easily from one version of R to a different version 
• integrate with your authentication, authorization, and audit practices

Download a free 45 day evaluation at  
www.rstudio.com/products/rstudio-server-pro/

WHY RSTUDIO SERVER PRO?4 WRITE CODE Windows /Linux Mac
Attempt completion Tab or Ctrl+Space Tab or Cmd+Space
Navigate candidates !/$ !/$
Accept candidate Enter, Tab, or # Enter, Tab, or #
Dismiss candidates Esc Esc
Undo Ctrl+Z Cmd+Z
Redo Ctrl+Shift+Z Cmd+Shift+Z
Cut Ctrl+X Cmd+X
Copy Ctrl+C Cmd+C
Paste Ctrl+V Cmd+V
Select All Ctrl+A Cmd+A
Delete Line Ctrl+D Cmd+D
Select Shift+[Arrow] Shift+[Arrow]
Select Word Ctrl+Shift+ "/# Option+Shift+ "/#
Select to Line Start Alt+Shift+" Cmd+Shift+"
Select to Line End Alt+Shift+# Cmd+Shift+#
Select Page Up/Down Shift+PageUp/Down Shift+PageUp/Down
Select to Start/End Shift+Alt+!/$ Cmd+Shift+!/$
Delete Word Left Ctrl+Backspace Ctrl+Opt+Backspace
Delete Word Right   Option+Delete
Delete to Line End   Ctrl+K
Delete to Line Start   Option+Backspace
Indent Tab (at start of line) Tab (at start of line)
Outdent Shift+Tab Shift+Tab
Yank line up to cursor Ctrl+U Ctrl+U
Yank line after cursor Ctrl+K Ctrl+K
Insert yanked text Ctrl+Y Ctrl+Y
Insert <- Alt+- Option+-
Insert %>% Ctrl+Shift+M Cmd+Shift+M
Show help for function F1 F1
Show source code 
unction

F2 F2
New document Ctrl+Shift+N Cmd+Shift+N
New document (Chrome) Ctrl+Alt+Shift+N Cmd+Shift+Opt+N
Open document Ctrl+O Cmd+O
Save document Ctrl+S Cmd+S
Close document Ctrl+W Cmd+W
Close document (Chrome) Ctrl+Alt+W Cmd+Option+W
Close all documents Ctrl+Shift+W Cmd+Shift+W
Extract function Ctrl+Alt+X Cmd+Option+X
Extract variable Ctrl+Alt+V Cmd+Option+V
Reindent lines Ctrl+I Cmd+I
(Un)Comment lines Ctrl+Shift+C Cmd+Shift+C
Reflow Comment Ctrl+Shift+/ Cmd+Shift+/
Reformat Selection Ctrl+Shift+A Cmd+Shift+A
Select within braces Ctrl+Shift+E Ctrl+Shift+E
Show Diagnostics Ctrl+Shift+Alt+P Cmd+Shift+Opt+P
Transpose Letters   Ctrl+T
Move Lines Up/Down Alt+!/$ Option+!/$
Copy Lines Up/Down Shift+Alt+!/$ Cmd+Option+!/$
Add New Cursor Above Ctrl+Alt+Up Ctrl+Option+Up
Add New Cursor Below Ctrl+Alt+Down Ctrl+Option+Down
Move Active Cursor Up Ctrl+Alt+Shift+Up Ctrl+Option+Shift+Up
Move Active Cursor Down Ctrl+Alt+Shift+Down Ctrl+Opt+Shift+Down
Find and Replace Ctrl+F Cmd+F
Use Selection for Find Ctrl+F3 Cmd+E
Replace and Find Ctrl+Shift+J Cmd+Shift+J
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Try one of the following packages to import 
other types of files 

• haven - SPSS, Stata, and SAS files 
• readxl - excel files (.xls and .xlsx) 
• DBI - databases 
• jsonlite - json 
• xml2 - XML 
• httr - Web APIs 
• rvest - HTML (Web Scraping)

R’s tidyverse is built around tidy data stored 
in  tibbles, which are enhanced data frames.  

The front side of this sheet shows 
how to read text files into R with 
readr. 

The reverse side shows how to 
create tibbles with tibble and to 
layout tidy data with tidyr. 

Save Data

Data Import : : CHEAT SHEET 
Read Tabular Data - These functions share the common arguments: Data types

USEFUL ARGUMENTS

OTHER TYPES OF DATA

Comma delimited file 
write_csv(x, path, na = "NA", append = FALSE, 

col_names = !append) 
File with arbitrary delimiter 

write_delim(x, path, delim = " ", na = "NA", 
append = FALSE, col_names = !append) 

CSV for excel 
write_excel_csv(x, path, na = "NA", append = 

FALSE, col_names = !append) 
String to file 

write_file(x, path, append = FALSE) 
String vector to file, one element per line 

write_lines(x,path, na = "NA", append = FALSE) 
Object to RDS file 

write_rds(x, path, compress = c("none", "gz", 
"bz2", "xz"), ...) 

Tab delimited files 
write_tsv(x, path, na = "NA", append = FALSE, 

col_names = !append)

Save x, an R object, to path, a file path, as:

Skip lines 
read_csv(f, skip = 1) 
  

Read in a subset 
read_csv(f, n_max = 1) 

  
Missing Values 
read_csv(f, na = c("1", "."))

Comma Delimited Files 
read_csv("file.csv") 

To make file.csv run:  
write_file(x = "a,b,c\n1,2,3\n4,5,NA", path = "file.csv") 

Semi-colon Delimited Files 
read_csv2("file2.csv") 

write_file(x = "a;b;c\n1;2;3\n4;5;NA", path = "file2.csv") 

Files with Any Delimiter  
read_delim("file.txt", delim = "|") 

write_file(x = "a|b|c\n1|2|3\n4|5|NA", path = "file.txt") 

Fixed Width Files 
read_fwf("file.fwf", col_positions = c(1, 3, 5))  

write_file(x = "a b c\n1 2 3\n4 5 NA", path = "file.fwf") 

Tab Delimited Files 
read_tsv("file.tsv") Also read_table(). 

write_file(x = "a\tb\tc\n1\t2\t3\n4\t5\tNA", path = "file.tsv")

a,b,c 
1,2,3 
4,5,NA

a;b;c 
1;2;3 
4;5;NA

a|b|c 
1|2|3 
4|5|NA

a  b  c 
1  2  3 
4  5  NA

A B C
1 2 3

A B C
1 2 3
4 5 NA

x y z
A B C
1 2 3
4 5 NA

A B C
NA 2 3
4 5 NA

1 2 3

4 5 NA

A B C
1 2 3
4 5 NA

A B C
1 2 3
4 5 NA

A B C
1 2 3
4 5 NA

A B C
1 2 3
4 5 NA

a,b,c 
1,2,3 
4,5,NA

Example file 
write_file("a,b,c\n1,2,3\n4,5,NA","file.csv") 
f <- "file.csv" 

No header 
read_csv(f, col_names = FALSE) 

Provide header 
read_csv(f, col_names = c("x", "y", "z"))

read_*(file, col_names = TRUE, col_types = NULL, locale = default_locale(), na = c("", "NA"), 
quoted_na = TRUE, comment = "", trim_ws = TRUE, skip = 0, n_max = Inf, guess_max = min(1000, 
n_max), progress = interactive())

Read a file into a single string 
read_file(file, locale = default_locale()) 

Read each line into its own string 
read_lines(file, skip = 0, n_max = -1L, na = character(), 

locale = default_locale(), progress = interactive())

Read a file into a raw vector 
read_file_raw(file) 

Read each line into a raw vector 
read_lines_raw(file, skip = 0, n_max = -1L, 

progress = interactive())

Read Non-Tabular Data

Read Apache style log files 
read_log(file, col_names = FALSE, col_types = NULL, skip = 0, n_max = -1, progress = interactive())

## Parsed with column specification: 
## cols( 
##   age = col_integer(), 
##   sex = col_character(), 
##   earn = col_double() 
## )

1. Use problems() to diagnose problems. 
x <- read_csv("file.csv"); problems(x) 

2. Use a col_ function to guide parsing. 
• col_guess() - the default 
• col_character() 
• col_double(), col_euro_double() 
• col_datetime(format = "") Also  

col_date(format = ""), col_time(format = "") 
• col_factor(levels, ordered = FALSE) 
• col_integer() 
• col_logical() 
• col_number(), col_numeric() 
• col_skip() 
x <- read_csv("file.csv", col_types = cols( 
    A = col_double(), 
    B = col_logical(), 
    C = col_factor())) 

3. Else, read in as character vectors then parse 
with a parse_ function. 

• parse_guess() 
• parse_character() 
• parse_datetime() Also parse_date() and 

parse_time() 
• parse_double() 
• parse_factor() 
• parse_integer() 
• parse_logical() 
• parse_number() 
x$A <- parse_number(x$A)

readr functions guess  
the types of each column and  
convert types when appropriate (but will NOT 
convert strings to factors automatically).  

A message shows the type of each column in the 
result.

earn is a double (numeric)
sex is a 

character

age is an 
integer
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separate_rows(data, ..., sep = "[^[:alnum:].]
+", convert = FALSE) 
Separate each cell in a column to make 
several rows. Also separate_rows_().

Handle Missing Values

Reshape Data - change the layout of values in a table

gather(data, key, value, ..., na.rm = FALSE,  
convert = FALSE, factor_key = FALSE) 
gather() moves column names into a key 
column, gathering the column values into a 
single value column.

spread(data, key, value, fill = NA, convert = FALSE, 
drop = TRUE, sep = NULL) 
spread() moves the unique values of a key 
column into the column names, spreading the 
values of a value column across the new columns.

Use gather() and spread() to reorganize the values of a table into a new layout.

gather(table4a, `1999`, `2000`,  
key = "year", value = "cases") spread(table2, type, count)

valuekey

country 1999 2000
A 0.7K 2K
B 37K 80K
C 212K 213K

table4a
country year cases

A 1999 0.7K
B 1999 37K
C 1999 212K
A 2000 2K
B 2000 80K
C 2000 213K

valuekey

country year cases pop
A 1999 0.7K 19M
A 2000 2K 20M
B 1999 37K 172M
B 2000 80K 174M
C 1999 212K 1T
C 2000 213K 1T

table2
country year type count

A 1999 cases 0.7K
A 1999 pop 19M
A 2000 cases 2K
A 2000 pop 20M
B 1999 cases 37K
B 1999 pop 172M
B 2000 cases 80K
B 2000 pop 174M
C 1999 cases 212K
C 1999 pop 1T
C 2000 cases 213K
C 2000 pop 1T

unite(data, col, ..., sep = "_", remove = TRUE) 
Collapse cells across several columns to 
make a single column.

drop_na(data, ...) 
Drop rows containing 
NA’s in … columns.

fill(data, ..., .direction = c("down", "up")) 
Fill in NA’s in … columns with most 
recent non-NA values.

replace_na(data,  
replace = list(), ...) 
Replace NA’s by column.

Use these functions to 
split or combine cells 
into individual, isolated 
values.

country year rate
A 1999 0.7K/19M
A 2000 2K/20M
B 1999 37K/172M
B 2000 80K/174M
C 1999 212K/1T
C 2000 213K/1T

country year cases pop
A 1999 0.7K 19M
A 2000 2K 20M
B 1999 37K 172
B 2000 80K 174
C 1999 212K 1T
C 2000 213K 1T

table3

separate(data, col, into,  sep = "[^[:alnum:]]
+", remove = TRUE, convert = FALSE,  
extra = "warn", fill = "warn", ...) 
Separate each cell in a column to make 
several columns.

country century year
Afghan 19 99
Afghan 20 0
Brazil 19 99
Brazil 20 0
China 19 99
China 20 0

country year
Afghan 1999
Afghan 2000
Brazil 1999
Brazil 2000
China 1999
China 2000

table5

separate(table3, rate,  
into = c("cases", "pop"))

separate_rows(table3, rate)

unite(table5, century, year,  
col = "year", sep = "")

x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
D 3

x
x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
B 1
C 1
D 3
E 3

x
x1 x2
A 1
B NA
C NA
D 3
E NA

x1 x2
A 1
B 2
C 2
D 3
E 2

x

drop_na(x, x2) fill(x, x2) replace_na(x, list(x2 = 2))

country year rate
A 1999 0.7K
A 1999 19M
A 2000 2K
A 2000 20M
B 1999 37K
B 1999 172M
B 2000 80K
B 2000 174M
C 1999 212K
C 1999 1T
C 2000 213K
C 2000 1T

table3
country year rate

A 1999 0.7K/19M
A 2000 2K/20M
B 1999 37K/172M
B 2000 80K/174M
C 1999 212K/1T
C 2000 213K/1T

Tidy data is a way to organize tabular data. It provides a consistent data structure across packages.

CBA
A * B -> C
*A B C

Each observation, or 
case,  is in its own row

A B C

Each variable is in 
its own column

A B C

&
A table is tidy if: Tidy data:

Makes variables easy 
to access as vectors

Preserves cases during 
vectorized operations

complete(data, ..., fill = list()) 
Adds to the data missing combinations of the 
values of the variables listed in …   
complete(mtcars, cyl, gear, carb)

expand(data, ...) 
Create new tibble with all possible combinations 
of the values of the variables listed in …   
expand(mtcars, cyl, gear, carb)

The tibble package provides a new  
S3 class for storing tabular data, the  
tibble. Tibbles inherit the data frame  
class, but improve three behaviors: 

• Subsetting - [ always returns a new tibble, 
[[ and $ always return a vector. 

• No partial matching - You must use full  
column names when subsetting 

• Display - When you print a tibble, R provides a  
concise view of the  
data that fits on  
one screen
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Tibbles - an enhanced data frame Split Cells

• Control the default appearance with options: 
options(tibble.print_max = n, 

tibble.print_min = m, tibble.width = Inf) 

• View full data set with View() or glimpse() 
• Revert to data frame with as.data.frame()

data frame display

tibble display

tibble(…)  
Construct by columns. 
tibble(x = 1:3, y = c("a", "b", "c")) 

tribble(…)  
Construct by rows. 
tribble( ~x,     ~y, 
                   1,    "a", 
                   2,    "b", 
                   3,    "c")

A tibble: 3 × 2 
      x     y 
  <int> <chr> 
1     1     a 
2     2     b 
3     3     c

Both  
make this 

 tibble

ww

# A tibble: 234 × 6 
   manufacturer      model displ 
          <chr>      <chr> <dbl> 
1          audi         a4   1.8 
2          audi         a4   1.8 
3          audi         a4   2.0 
4          audi         a4   2.0 
5          audi         a4   2.8 
6          audi         a4   2.8 
7          audi         a4   3.1 
8          audi a4 quattro   1.8 
9          audi a4 quattro   1.8 
10         audi a4 quattro   2.0 
# ... with 224 more rows, and 3 
#   more variables: year <int>, 
#   cyl <int>, trans <chr>

156 1999   6   auto(l4) 
157 1999   6   auto(l4) 
158 2008   6   auto(l4) 
159 2008   8   auto(s4) 
160 1999   4 manual(m5) 
161 1999   4   auto(l4) 
162 2008   4 manual(m5) 
163 2008   4 manual(m5) 
164 2008   4   auto(l4) 
165 2008   4   auto(l4) 
166 1999   4   auto(l4) 
 [ reached getOption("max.print") 
-- omitted 68 rows ]A large table 

to display

as_tibble(x, …) Convert data frame to tibble.  

enframe(x, name = "name", value = "value") 
Convert named vector to a tibble 

is_tibble(x) Test whether x is a tibble.

CONSTRUCT A TIBBLE IN TWO WAYS

Expand Tables - quickly create tables with combinations of values

Tidy Data with tidyr
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Summarise Cases

group_by(.data, ..., add = 
FALSE) 
Returns copy of table  
grouped by …  
g_iris <- group_by(iris, Species) 

ungroup(x, …) 
Returns ungrouped copy  
of table.  
ungroup(g_iris)

wwwwwwwww

Use group_by() to create a "grouped" copy of a table.  
dplyr functions will manipulate each "group" separately and 
then combine the results.

mtcars %>% 
group_by(cyl) %>% 
summarise(avg = mean(mpg))

These apply summary functions to columns to create a new 
table of summary statistics. Summary functions take vectors as 
input and return one value (see back).

VARIATIONS 
summarise_all() - Apply funs to every column. 
summarise_at() - Apply funs to specific columns.  
summarise_if() - Apply funs to all cols of one type.

www
www

summarise(.data, …) 
Compute table of summaries.  
summarise(mtcars, avg = mean(mpg)) 

count(x, ..., wt = NULL, sort = FALSE) 
Count number of rows in each group defined 
by the variables in … Also tally(). 
count(iris, Species)
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Each observation, or 
case, is in its own row

Each variable is in 
its own column

&

dplyr functions work with pipes and expect tidy data. In tidy data:

pipes

x %>% f(y)  
becomes  f(x, y) filter(.data, …) Extract rows that meet logical 

criteria. filter(iris, Sepal.Length > 7) 

distinct(.data, ..., .keep_all = FALSE) Remove 
rows with duplicate values.  
distinct(iris, Species) 

sample_frac(tbl, size = 1, replace = FALSE,  
weight = NULL, .env = parent.frame()) Randomly 
select fraction of rows.  
sample_frac(iris, 0.5, replace = TRUE) 

sample_n(tbl, size, replace = FALSE, weight = 
NULL, .env = parent.frame()) Randomly select 
size rows. sample_n(iris, 10, replace = TRUE) 

slice(.data, …) Select rows by position.  
slice(iris, 10:15) 

top_n(x, n, wt) Select and order top n entries (by 
group if grouped data). top_n(iris, 5, Sepal.Width)

Row functions return a subset of rows as a new table.

See ?base::logic and ?Comparison for help.
> >= !is.na() ! &
< <= is.na() %in% | xor()

arrange(.data, …) Order rows by values of a 
column or columns (low to high), use with 
desc() to order from high to low. 
arrange(mtcars, mpg) 
arrange(mtcars, desc(mpg))

add_row(.data, ..., .before = NULL, .after = NULL) 
Add one or more rows to a table. 
add_row(faithful, eruptions = 1, waiting = 1)

Group Cases

Manipulate Cases
EXTRACT VARIABLES

ADD CASES

ARRANGE CASES

Logical and boolean operators to use with filter()

Column functions return a set of columns as a new vector or table.

contains(match)  
ends_with(match)  
matches(match)

:, e.g. mpg:cyl 
-, e.g, -Species

num_range(prefix, range) 
one_of(…)  
starts_with(match) 

pull(.data,  var = -1) Extract column values as 
a vector.  Choose by name or index. 
pull(iris, Sepal.Length)

Manipulate Variables

Use these helpers with select (), 
e.g. select(iris, starts_with("Sepal"))

These apply vectorized functions to columns. Vectorized funs take 
vectors as input and return vectors of the same length as output 
(see back).

mutate(.data, …)  
Compute new column(s). 
mutate(mtcars, gpm = 1/mpg) 

transmute(.data, …) 
Compute new column(s), drop others. 
transmute(mtcars, gpm = 1/mpg) 

mutate_all(.tbl, .funs, …) Apply funs to every 
column. Use with funs(). Also mutate_if(). 
mutate_all(faithful, funs(log(.), log2(.))) 
mutate_if(iris, is.numeric, funs(log(.))) 

mutate_at(.tbl, .cols, .funs, …) Apply funs to 
specific columns. Use with funs(), vars() and 
the helper functions for select(). 
mutate_at(iris, vars( -Species), funs(log(.))) 

add_column(.data, ..., .before = NULL, .after = 
NULL) Add new column(s). Also add_count(), 
add_tally(). add_column(mtcars, new = 1:32) 

rename(.data, …) Rename columns. 
rename(iris, Length = Sepal.Length)

MAKE NEW VARIABLES

EXTRACT CASES

wwwwww
wwwwww
wwwwww

wwwwww

wwwwww

wwwwww

wwww

wwwww

wwwwww
www
wwww
www
wwwwww

dplyr

summary function

vectorized function

dplyr
Data Transformation with dplyr : : CHEAT SHEET 

A B CA B C

select(.data, …) 
Extract columns as a table. Also select_if(). 
select(iris, Sepal.Length, Species)wwww
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OFFSETS 
dplyr::lag() - Offset elements by 1 
dplyr::lead() - Offset elements by -1 

CUMULATIVE AGGREGATES 
dplyr::cumall() - Cumulative all() 
dplyr::cumany() - Cumulative any() 

cummax() - Cumulative max() 
dplyr::cummean() - Cumulative mean() 

cummin() - Cumulative min() 
cumprod() - Cumulative prod() 
cumsum() - Cumulative sum() 

RANKINGS 
dplyr::cume_dist() - Proportion of all values <= 
dplyr::dense_rank() - rank with ties = min, no 
gaps 
dplyr::min_rank() - rank with ties = min 
dplyr::ntile() - bins into n bins 
dplyr::percent_rank() - min_rank scaled to [0,1] 
dplyr::row_number() - rank with ties = "first" 

MATH 
+, - , *, /, ^, %/%, %% - arithmetic ops 
log(), log2(), log10() - logs 
<, <=, >, >=, !=, == - logical comparisons 

dplyr::between() - x >= left & x <= right 
dplyr::near() - safe == for floating point 
numbers 

MISC 
dplyr::case_when() - multi-case if_else() 
dplyr::coalesce() - first non-NA values by 
element  across a set of vectors 
dplyr::if_else() - element-wise if() + else() 
dplyr::na_if() - replace specific values with NA 

pmax() - element-wise max() 
pmin() - element-wise min() 

dplyr::recode() - Vectorized switch() 
dplyr::recode_factor() - Vectorized switch() 
for factors 

mutate() and transmute() apply vectorized 
functions to columns to create new columns. 
Vectorized functions take vectors as input and 
return vectors of the same length as output.

Vector Functions
TO USE WITH MUTATE ()

vectorized function

Summary Functions
TO USE WITH SUMMARISE ()

summarise() applies summary functions to 
columns to create a new table. Summary 
functions take vectors as input and return single 
values as output.

COUNTS 
dplyr::n() - number of values/rows 
dplyr::n_distinct() - # of uniques 

sum(!is.na()) - # of non-NA’s 

LOCATION 
mean() - mean, also mean(!is.na()) 
median() - median 

LOGICALS 
mean() - Proportion of TRUE’s 
sum() - # of TRUE’s 

POSITION/ORDER 
dplyr::first() - first value 
dplyr::last() - last value 
dplyr::nth() - value in nth location of vector 

RANK 
quantile() - nth quantile  
min() - minimum value 
max() - maximum value 

SPREAD 
IQR() - Inter-Quartile Range 
mad() - median absolute deviation 
sd() - standard deviation 
var() - variance

Row Names
Tidy data does not use rownames, which store a 
variable outside of the columns. To work with the 
rownames, first move them into a column. 
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rownames_to_column() 
Move row names into col. 
a <- rownames_to_column(iris, var 
= "C") 

column_to_rownames() 
Move col in row names.  
column_to_rownames(a, var = "C") 

summary function

C A B

Also has_rownames(), remove_rownames()

Combine Tables
COMBINE VARIABLES COMBINE CASES

Use bind_cols() to paste tables beside each 
other as they are.  

bind_cols(…) Returns tables placed side by 
side as a single table.  
BE SURE THAT ROWS ALIGN. 

Use a "Mutating Join" to join one table to 
columns from another, matching values with 
the rows that they correspond to.  Each join 
retains a different combination of values from 
the tables. 

left_join(x, y, by = NULL, 
copy=FALSE,  suffix=c(“.x”,“.y”),…) 
Join matching values from y to x. 

right_join(x, y, by = NULL, copy = 
FALSE,  suffix=c(“.x”,“.y”),…) 
Join matching values from x to y. 

inner_join(x, y, by = NULL, copy = 
FALSE,  suffix=c(“.x”,“.y”),…) 
Join data. Retain only rows with 
matches. 

full_join(x, y, by = NULL, 
copy=FALSE,  suffix=c(“.x”,“.y”),…) 
Join data. Retain all values, all rows. 

Use by = c("col1", "col2")  to 
specify the column(s) to match on. 
left_join(x, y, by = "A") 

Use a named vector,  by = c("col1" = 
"col2"), to match on columns with 
different names in each data set. 
left_join(x, y, by = c("C" = "D")) 

Use suffix to specify suffix to give to 
duplicate column names. 
left_join(x, y, by = c("C" = "D"), suffix = 
c("1", "2"))

Use bind_rows() to paste tables below each 
other as they are. 

bind_rows(…, .id = NULL) 
Returns tables one on top of the other 
as a single table. Set .id to a column 
name to add a column of the original 
table names (as pictured) 

intersect(x, y, …) 
Rows that appear in both x and y. 

setdiff(x, y, …) 
Rows that appear in x but not y. 

union(x, y, …) 
Rows that appear in x or y.  
(Duplicates removed). union_all() 
retains duplicates.

Use a "Filtering Join" to filter one table against 
the rows of another. 

semi_join(x, y, by = NULL, …) 
Return rows of x that have a match in y. 
USEFUL TO SEE WHAT WILL BE JOINED. 

anti_join(x, y, by = NULL, …) 
Return rows of x that do not have a 
match in y. USEFUL TO SEE WHAT WILL 
NOT BE JOINED.

Use setequal() to test whether two data sets 
contain the exact same rows (in any order). 

dplyr

EXTRACT ROWS

A B
1 a t
2 b u
3 c v

1 a t
2 b u
3 c v

A B
1 a t
2 b u
3 c v

A B C
1 a t
2 b u
3 c v

x y
A B C
a t 1
b u 2
c v 3

A B D
a t 3
b u 2
d w 1

+ =
A B C
a t 1
b u 2
c v 3

A B D
a t 3
b u 2
d w 1

A B C D
a t 1 3
b u 2 2
c v 3 NA

A B C D
a t 1 3
b u 2 2
d w NA 1

A B C D
a t 1 3
b u 2 2

A B C D
a t 1 3
b u 2 2
c v 3 NA

d w NA 1

A B.x C B.y D
a t 1 t 3
b u 2 u 2
c v 3 NA NA

A.x B.x C A.y B.y
a t 1 d w
b u 2 b u
c v 3 a t

A1 B1 C A2 B2
a t 1 d w
b u 2 b u
c v 3 a t

x

y

A B C
a t 1
b u 2
c v 3

A B C
C v 3
d w 4+

DF A B C
x a t 1
x b u 2
x c v 3
z c v 3
z d w 4

A B C
c v 3

A B C
a t 1
b u 2
c v 3
d w 4

A B C
a t 1
b u 2

x y
A B C
a t 1
b u 2
c v 3

A B D
a t 3
b u 2
d w 1

+ =

A B C
c v 3

A B C
a t 1
b u 2
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ggplot (data =  <DATA> ) +  
  <GEOM_FUNCTION> (mapping = aes( <MAPPINGS> ),  
  stat = <STAT> , position = <POSITION> ) +      
  <COORDINATE_FUNCTION> + 
  <FACET_FUNCTION>  + 
  <SCALE_FUNCTION>  + 
  <THEME_FUNCTION>

ggplot2 is based on the grammar of graphics, the idea 
that you can build every graph from the same 
components: a data set, a coordinate system, 
and geoms—visual marks that represent data points.

Basics
GRAPHICAL PRIMITIVES

a + geom_blank() 
(Useful for expanding limits) 

b + geom_curve(aes(yend = lat + 1, 
xend=long+1,curvature=z)) - x, xend, y, yend, 
alpha, angle, color, curvature, linetype, size 

a + geom_path(lineend="butt", linejoin="round", 
linemitre=1) 
x, y, alpha, color, group, linetype, size 

a + geom_polygon(aes(group = group)) 
x, y, alpha, color, fill, group, linetype, size 

b + geom_rect(aes(xmin = long, ymin=lat, xmax= 
long + 1, ymax = lat + 1)) - xmax, xmin, ymax, 
ymin, alpha, color, fill, linetype, size 

a + geom_ribbon(aes(ymin=unemploy - 900, 
ymax=unemploy + 900)) - x, ymax, ymin, 
alpha, color, fill, group, linetype, size

+ =

Data Visualization with ggplot2 : : CHEAT SHEET 

To display values, map variables in the data to visual 
properties of the geom (aesthetics) like size, color, and x 
and y locations.

+ =

data geom 
x = F · y = A

coordinate 
system

plot

data geom 
x = F · y = A 
color = F 
size = A

coordinate 
system

plot

Complete the template below to build a graph.
required

ggplot(data = mpg, aes(x = cty, y = hwy)) Begins a plot 
that you finish by adding layers to. Add one geom 
function per layer.      
  

qplot(x = cty, y = hwy, data = mpg, geom = “point") 
Creates a complete plot with given data, geom, and 
mappings. Supplies many useful defaults.     

last_plot() Returns the last plot  

ggsave("plot.png", width = 5, height = 5) Saves last plot 
as 5’ x 5’ file named "plot.png" in working directory. 
Matches file type to file extension.

F M A

F M A

aesthetic mappings data geom

LINE SEGMENTS

b + geom_abline(aes(intercept=0, slope=1)) 
b + geom_hline(aes(yintercept = lat)) 
b + geom_vline(aes(xintercept = long))

common aesthetics: x, y, alpha, color, linetype, size

b + geom_segment(aes(yend=lat+1, xend=long+1)) 
b + geom_spoke(aes(angle = 1:1155, radius = 1))

a <- ggplot(economics, aes(date, unemploy)) 
b <- ggplot(seals, aes(x = long, y = lat))

ONE VARIABLE    continuous
c <- ggplot(mpg, aes(hwy)); c2 <- ggplot(mpg)

c + geom_area(stat = "bin") 
x, y, alpha, color, fill,  linetype, size 

c + geom_density(kernel = "gaussian") 
x, y, alpha, color, fill, group, linetype, size, weight 

c + geom_dotplot()  
x, y, alpha, color, fill 

c + geom_freqpoly() x, y, alpha, color, group, 
linetype, size 

c + geom_histogram(binwidth = 5) x, y, alpha, 
color, fill, linetype, size, weight 

c2 + geom_qq(aes(sample = hwy)) x, y, alpha, 
color, fill, linetype, size, weight

discrete
d <- ggplot(mpg, aes(fl))

d + geom_bar()  
x, alpha, color, fill, linetype, size, weight

e + geom_label(aes(label = cty), nudge_x = 1, 
nudge_y = 1, check_overlap = TRUE) x, y, label, 
alpha, angle, color, family, fontface, hjust, 
lineheight, size, vjust 

e + geom_jitter(height = 2, width = 2)  
x, y, alpha, color, fill, shape, size 

e + geom_point(), x, y, alpha, color, fill, shape, 
size, stroke 

e + geom_quantile(), x, y, alpha, color, group, 
linetype, size, weight 

e + geom_rug(sides = "bl"), x, y, alpha, color, 
linetype, size 

e + geom_smooth(method = lm), x, y, alpha, 
color, fill, group, linetype, size, weight 

e + geom_text(aes(label = cty), nudge_x = 1, 
nudge_y = 1, check_overlap = TRUE), x, y, label, 
alpha, angle, color, family, fontface, hjust, 
lineheight, size, vjust

discrete x , continuous y 
f <- ggplot(mpg, aes(class, hwy))

f + geom_col(), x, y, alpha, color, fill, group, 
linetype, size 

f + geom_boxplot(), x, y, lower, middle, upper, 
ymax, ymin, alpha, color, fill, group, linetype, 
shape, size, weight 

f + geom_dotplot(binaxis = "y", stackdir = 
"center"), x, y, alpha, color, fill, group 

f + geom_violin(scale = "area"), x, y, alpha, color, 
fill, group, linetype, size, weight

discrete x , discrete y 
g <- ggplot(diamonds, aes(cut, color))

g + geom_count(), x, y, alpha, color, fill, shape, 
size, stroke

THREE VARIABLES 
seals$z <- with(seals, sqrt(delta_long^2 + delta_lat^2))l <- ggplot(seals, aes(long, lat))

l + geom_contour(aes(z = z)) 
x, y, z, alpha, colour, group, linetype,  
size, weight

l + geom_raster(aes(fill = z), hjust=0.5, vjust=0.5, 
interpolate=FALSE) 
x, y, alpha, fill 

l + geom_tile(aes(fill = z)), x, y, alpha, color, fill, 
linetype, size, width

h + geom_bin2d(binwidth = c(0.25, 500)) 
x, y, alpha, color, fill, linetype, size, weight 

h + geom_density2d() 
x, y, alpha, colour, group, linetype, size 

h + geom_hex() 
x, y, alpha, colour, fill, size 

 

i + geom_area() 
x, y, alpha, color, fill, linetype, size 

i + geom_line() 
x, y, alpha, color, group, linetype, size 

i + geom_step(direction = "hv") 
x, y, alpha, color, group, linetype, size 
 
 
 

j + geom_crossbar(fatten = 2) 
x, y, ymax, ymin, alpha, color, fill, group, linetype, 
size 

j + geom_errorbar(), x, ymax, ymin, alpha, color, 
group, linetype, size, width (also 
geom_errorbarh()) 

j + geom_linerange() 
x, ymin, ymax, alpha, color, group, linetype, size 

j + geom_pointrange() 
x, y, ymin, ymax, alpha, color, fill, group, linetype, 
shape, size

continuous function 
i <- ggplot(economics, aes(date, unemploy))

visualizing error 
df <- data.frame(grp = c("A", "B"), fit = 4:5, se = 1:2) 
j <- ggplot(df, aes(grp, fit, ymin = fit-se, ymax = fit+se))

maps 
data <- data.frame(murder = USArrests$Murder, 
state = tolower(rownames(USArrests))) 
map <- map_data("state") 
k <- ggplot(data, aes(fill = murder))

k + geom_map(aes(map_id = state), map = map) 
+ expand_limits(x = map$long, y = map$lat), 
map_id, alpha, color, fill, linetype, size

Not  
required, 
sensible 
defaults 
supplied

Geoms Use a geom function to represent data points, use the geom’s aesthetic properties to represent variables.  
Each function returns a layer.

TWO VARIABLES 
continuous x , continuous y 
e <- ggplot(mpg, aes(cty, hwy))

 
continuous bivariate distribution 
h <- ggplot(diamonds, aes(carat, price))
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Scales Coordinate Systems
A stat builds new variables to plot (e.g., count, prop). 

Stats  An alternative way to build a layer

+ =
data geom 

x = x · 
y = ..count..

coordinate 
system

plot

fl cty cyl

x ..count..

stat

Visualize a stat by changing the default stat of a geom 
function, geom_bar(stat="count") or by using a stat 
function, stat_count(geom="bar"), which calls a default 
geom to make a layer (equivalent to a geom function). 
Use ..name.. syntax to map stat variables to aesthetics.

i + stat_density2d(aes(fill = ..level..),  
geom = "polygon")

stat function geommappings

variable created by stat

geom to use

c + stat_bin(binwidth = 1, origin = 10) 
x, y |  ..count.., ..ncount.., ..density.., ..ndensity.. 
c + stat_count(width = 1)  x, y, |  ..count.., ..prop.. 
c + stat_density(adjust = 1, kernel = “gaussian")  
x, y, |  ..count.., ..density.., ..scaled.. 

e + stat_bin_2d(bins = 30, drop = T) 
x, y, fill |  ..count.., ..density.. 
e + stat_bin_hex(bins=30) x, y, fill |  ..count.., ..density.. 
e + stat_density_2d(contour = TRUE, n = 100) 
x, y, color, size |  ..level.. 
e + stat_ellipse(level = 0.95, segments = 51, type = "t") 

l + stat_contour(aes(z = z)) x, y, z, order |  ..level.. 
l + stat_summary_hex(aes(z = z), bins = 30, fun = max) 
x, y, z, fill |  ..value.. 
l + stat_summary_2d(aes(z = z), bins = 30, fun = mean) 
x, y, z, fill |  ..value.. 

f + stat_boxplot(coef = 1.5) x, y |  ..lower..,  
..middle.., ..upper.., ..width.. , ..ymin.., ..ymax.. 
f + stat_ydensity(kernel = "gaussian", scale = “area") x, y |  
..density.., ..scaled.., ..count.., ..n.., ..violinwidth.., ..width.. 

e + stat_ecdf(n = 40)  x, y |  ..x.., ..y.. 
e + stat_quantile(quantiles = c(0.1, 0.9), formula = y ~ 
log(x), method = "rq")  x, y | ..quantile.. 
e + stat_smooth(method = "lm", formula = y ~ x, se=T, 
level=0.95) x, y | ..se.., ..x.., ..y.., ..ymin.., ..ymax.. 

ggplot() + stat_function(aes(x = -3:3), n = 99,  fun = 
dnorm, args = list(sd=0.5)) x |  ..x.., ..y.. 
e + stat_identity(na.rm = TRUE) 
ggplot() + stat_qq(aes(sample=1:100), dist = qt, 
dparam=list(df=5)) sample, x, y |  ..sample.., ..theoretical.. 
e + stat_sum() x, y, size |  ..n.., ..prop.. 
e + stat_summary(fun.data = "mean_cl_boot") 
h + stat_summary_bin(fun.y = "mean", geom = "bar") 
e + stat_unique()

Scales map data values to the visual values of an 
aesthetic. To change a mapping, add a new scale.

(n <- d + geom_bar(aes(fill = fl)))

n + scale_fill_manual( 
values = c("skyblue", "royalblue", "blue", “navy"), 
limits = c("d", "e", "p", "r"), breaks =c("d", "e", "p", “r"), 
name = "fuel", labels = c("D", "E", "P", "R"))

scale_
aesthetic 
to adjust

prepackaged 
scale to use

scale-specific 
arguments

title to use in 
legend/axis

labels to use 
in legend/axis

breaks to use in 
legend/axis

range of 
values to include 

in mapping

GENERAL PURPOSE SCALES 
Use with most aesthetics 
scale_*_continuous() - map cont’ values to visual ones 
scale_*_discrete() - map discrete values to visual ones 
scale_*_identity() - use data values as visual ones 
scale_*_manual(values = c()) - map discrete values to 
manually chosen visual ones 
scale_*_date(date_labels = "%m/%d"), date_breaks = "2 
weeks") - treat data values as dates.  
scale_*_datetime() -  treat data x values as date times. 
Use same arguments as scale_x_date(). See ?strptime for 
label formats.

X & Y LOCATION SCALES 
Use with x or y aesthetics (x shown here) 
scale_x_log10() - Plot x on log10 scale 
scale_x_reverse() - Reverse direction of x axis 
scale_x_sqrt() - Plot x on square root scale

COLOR AND FILL SCALES (DISCRETE) 
n <- d + geom_bar(aes(fill = fl)) 
n + scale_fill_brewer(palette = "Blues")  
For palette choices: 
RColorBrewer::display.brewer.all() 
n + scale_fill_grey(start = 0.2, end = 0.8,  
na.value = "red") 

COLOR AND FILL SCALES (CONTINUOUS) 
o <- c + geom_dotplot(aes(fill = ..x..)) 

o + scale_fill_distiller(palette = "Blues") 
 
o + scale_fill_gradient(low="red", high="yellow") 
 
o + scale_fill_gradient2(low="red", high=“blue", 
mid = "white", midpoint = 25)  
 
o + scale_fill_gradientn(colours=topo.colors(6))  
Also: rainbow(), heat.colors(), terrain.colors(), 
cm.colors(), RColorBrewer::brewer.pal()

SHAPE AND SIZE SCALES 
p <- e + geom_point(aes(shape = fl, size = cyl)) 
p + scale_shape() + scale_size() 
p + scale_shape_manual(values = c(3:7)) 

p + scale_radius(range = c(1,6)) 
p + scale_size_area(max_size = 6)

r <- d + geom_bar() 
r + coord_cartesian(xlim = c(0, 5))  
xlim, ylim 
The default cartesian coordinate system 
r + coord_fixed(ratio = 1/2)  
ratio, xlim, ylim 
Cartesian coordinates with fixed aspect ratio 
between x and y units 
r + coord_flip()  
xlim, ylim 
Flipped Cartesian coordinates 
r + coord_polar(theta = "x", direction=1 )  
theta, start, direction 
Polar coordinates 
r + coord_trans(ytrans = “sqrt")  
xtrans, ytrans, limx, limy 
Transformed cartesian coordinates. Set xtrans and 
ytrans to the name of a window function. 

π + coord_quickmap() 
π + coord_map(projection = "ortho", 
orientation=c(41, -74, 0))projection, orienztation, 
xlim, ylim 
Map projections from the mapproj package 
(mercator (default), azequalarea, lagrange, etc.)

60

long
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Position Adjustments
Position adjustments determine how to arrange geoms 
that would otherwise occupy the same space. 

s <- ggplot(mpg, aes(fl, fill = drv)) 
s + geom_bar(position = "dodge") 
Arrange elements side by side 
s + geom_bar(position = "fill") 
Stack elements on top of one another,  
normalize height 
e + geom_point(position = "jitter") 
Add random noise to X and Y position of each 
element to avoid overplotting 
e + geom_label(position = "nudge") 
Nudge labels away from points 

s + geom_bar(position = "stack") 
Stack elements on top of one another 

Each position adjustment can be recast as a function with 
manual width and height arguments 
s + geom_bar(position = position_dodge(width = 1))

A
B

Themes
r + theme_bw() 
White background 
with grid lines 
r + theme_gray() 
Grey background  
(default theme) 
r + theme_dark() 
dark for contrast 

r + theme_classic() 
r + theme_light() 
r + theme_linedraw() 
r + theme_minimal() 
Minimal themes 
r + theme_void() 
Empty theme

Faceting
Facets divide a plot into  
subplots based on the  
values of one or more  
discrete variables. 

t <- ggplot(mpg, aes(cty, hwy)) + geom_point() 

t + facet_grid(. ~ fl) 
facet into columns based on fl 
t + facet_grid(year ~ .) 
facet into rows based on year 
t + facet_grid(year ~ fl) 
facet into both rows and columns 
t + facet_wrap(~ fl) 
wrap facets into a rectangular layout 

Set scales to let axis limits vary across facets 

t + facet_grid(drv ~ fl, scales = "free") 
x and y axis limits adjust to individual facets 
"free_x" - x axis limits adjust 
"free_y" - y axis limits adjust 

Set labeller to adjust facet labels 

t + facet_grid(. ~ fl, labeller = label_both) 

t + facet_grid(fl ~ ., labeller = label_bquote(alpha ^ .(fl))) 

t + facet_grid(. ~ fl, labeller = label_parsed)

fl: c fl: d fl: e fl: p fl: r

c d e p r

↵c ↵d ↵e ↵p ↵r

Labels
t + labs(    x = "New x axis label",  y = "New y axis label", 
title ="Add a title above the plot",  
subtitle = "Add a subtitle below title", 
caption = "Add a caption below plot", 
   <aes>  = "New   <aes>    legend title")  
t + annotate(geom = "text", x = 8, y = 9, label = "A")

Use scale functions 
 to update legend 
labels

<AES>

geom to place manual values for geom’s aesthetics

<AES>

Legends
n + theme(legend.position = "bottom") 
Place legend at "bottom", "top", "left", or "right" 
n + guides(fill = "none") 
Set legend type for each aesthetic: colorbar, legend, or 
none (no legend)  
n + scale_fill_discrete(name = "Title",  
labels = c("A", "B", "C", "D", "E")) 
Set legend title and labels with a scale function.

Zooming
Without clipping (preferred) 
t + coord_cartesian( 
xlim = c(0, 100), ylim = c(10, 20)) 
With clipping (removes unseen data points) 
t + xlim(0, 100) + ylim(10, 20) 
t + scale_x_continuous(limits = c(0, 100)) + 
scale_y_continuous(limits = c(0, 100))
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YAML Header  
Optional section of render (e.g. pandoc)  
options written as key:value pairs (YAML). 
At start of file 
Between lines of  - - -  
Text 
Narration formatted with markdown, mixed with: 
Code Chunks 
Chunks of embedded code. Each chunk: 
Begins with ```{r} 
ends with ``` 
R Markdown will run the code and append the results to the doc. 
It will use the location of the .Rmd file  as the working directory

Interactive 
Documents
Turn your report into an interactive Shiny  
document in 4 steps 
1. Add runtime: shiny to the YAML header. 
2. Call Shiny input functions to embed input objects. 
3. Call Shiny render functions to embed reactive output. 
4. Render with rmarkdown::run  or click Run Document in 
RStudio IDE

--- 
output: html_document 
runtime: shiny 
--- 

```{r, echo = FALSE} 
numericInput("n",    
  "How many cars?", 5) 

renderTable({ 
  head(cars, input$n) 
}) 
```

Embed a complete app into your document with 
shiny::shinyAppDir() 
NOTE: Your report will rendered as a Shiny app, which means 
you must choose an html output format, like html_document, 
and serve it with an active R Session.

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA  RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at rmarkdown.rstudio.com  •  rmarkdown  1.6  •  Updated: 2016-02

R Markdown : : CHEAT SHEET 

Open a new .Rmd file at File ▶ New File ▶  
R Markdown. Use the wizard that opens  to pre-
populate the file with a template 
Write document by editing template 

Knit document to create report; use knit button or 
render() to knit 

Preview Output in IDE window 

Publish (optional) to web server 
Examine build log in R Markdown console 

Use output file that is saved along side .Rmd

1

2
3

4
5
6
7

modify 
chunk 
options

run all 
previous 
chunks

run 
current 
chunk

insert 
code 
chunk go to 

code 
chunk

run code 
chunk(s)

1

2

3 4

5

6

7

publish

show 
outline

synch publish 
button to 
accounts at 
rpubs.com, 
shinyapps.io  
RStudio  
Connect

Reload document

Find in document

File path to output document

set 
preview 
location

What is R Markdown?

Insert with `r <code>`. Results appear as text without code. One or more lines surrounded with ```{r} and ```. Place chunk 
options within curly braces, after r. Insert with

Options not listed above: R.options, aniopts, autodep, background, cache.comments, cache.lazy, cache.rebuild, cache.vars, dev, dev.args, dpi, 
engine.opts, engine.path, fig.asp, fig.env, fig.ext, fig.keep, fig.lp, fig.path, fig.pos, fig.process, fig.retina, fig.scap, fig.show, fig.showtext, fig.subcap, interval, 
out.extra, out.height, out.width, prompt, purl, ref.label, render, size, split, tidy.opts

Embed code with knitr syntax
Built with `r getRversion()`                Built with 3.2.3

INLINE CODE CODE CHUNKS

```{r echo=TRUE}  
getRversion() 
```

Set with knitr::opts_chunk$set(), e.g.
GLOBAL OPTIONS

```{r include=FALSE}  
knitr::opts_chunk$set(echo = TRUE) 
```

Use rmarkdown::render() to render/knit at cmd line. Important args:

Workflow

input - file to render 
output_format

render

rmarkdown

Parameters
Parameterize your documents to reuse with 
different inputs (e.g., data, values, etc.)

--- 
params:  
  n: 100 
  d: !r Sys.Date() 
---

Today’s date  
is `r params$d`

1. Add parameters · Create and set 
parameters in the header as sub-
values of params 

2. Call parameters · Call parameter 
values in code as params$<name> 

3. Set parameters · Set values wth 
Knit with parameters or the params 
argument of render(): 
render("doc.Rmd", params = list(n = 1, 
d = as.Date("2015-01-01")) 

output_options -  
List of render  
options (as in YAML)

output_file  
output_dir 

params - list of 
params to use

envir - environment  
to evaluate code 
chunks in

encoding - of input 
file

.rmd Structure
.Rmd files · An R Markdown  
(.Rmd) file is a record of your  
research. It contains the code that a 
scientist needs to reproduce your work 
along with the narration that a reader 
needs to understand your work. 
Reproducible Research · At the click of a 
button, or the type of a command, you 
can rerun the code in an R Markdown file 
to reproduce your work and export the 
results as a finished report. 
Dynamic Documents · You can choose 
to export the finished report in a variety 
of formats, including html, pdf, MS 
Word, or RTF documents; html or pdf 
based slides, Notebooks, and more.

Rmd

cache - cache results for future knits (default = 
FALSE) 
cache.path - directory to save cached results in 
(default = "cache/") 
child - file(s) to knit and then include (default = 
NULL) 
collapse - collapse all output into single block 
(default = FALSE) 
comment - prefix for each line of results (default = '##')

dependson - chunk dependencies for caching 
(default = NULL) 
echo - Display code in output document (default = 
TRUE) 
engine - code language used in chunk (default = 
'R') 
error - Display error messages in doc (TRUE) or 
stop render when errors occur (FALSE) (default = 
FALSE) 
eval - Run code in chunk (default = TRUE)

message - display code messages in  
document (default = TRUE) 
results  (default = 'markup') 
'asis' - passthrough results 
'hide' - do not display results 
'hold' - put all results below all code 
tidy - tidy code for display (default = FALSE) 
warning - display code warnings in document 
(default = TRUE)

fig.align - 'left', 'right', or 'center' (default = 
'default') 
fig.cap - figure caption as character string (default 
= NULL) 
fig.height, fig.width - Dimensions of plots in 
inches 
highlight - highlight source code (default = TRUE) 
include - Include chunk in doc after running 
(default = TRUE)

IMPORTANT CHUNK OPTIONS
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```{r results = 'asis'} 
knitr::kable(data, caption = "Table with kable”) 
``` 
```{r results = "asis"} 
print(xtable::xtable(data, caption = "Table with xtable”),  
            type = "html", html.table.attributes = "border=0")) 
``` 
```{r results = "asis"}  
stargazer::stargazer(data, type = "html", title = "Table  
                                            with stargazer") 
```

Plain text   
End a line with two spaces  
to start a new paragraph.   
*italics* and **bold**   
`verbatim code`   
sub/superscript^2^~2~   
~~strikethrough~~   
escaped: \* \_ \\   
endash: --, emdash: ---   
equation: $A = \pi*r^{2}$   
equation block: 

$$E = mc^{2}$$ 

> block quote   

# Header1  {#anchor} 

## Header 2  {#css_id} 

### Header 3  {.css_class} 

#### Header 4   

##### Header 5   

###### Header 6   

<!--Text comment--> 

\textbf{Tex ignored in HTML} 
<em>HTML ignored in pdfs</em>  

<http://www.rstudio.com>   
[link](www.rstudio.com)   
Jump to [Header 1](#anchor)   
image:  

![Caption](smallorb.png) 

* unordered list 
    + sub-item 1 
    + sub-item 2 
        - sub-sub-item 1 
   
* item 2 

    Continued (indent 4 spaces) 
     
1. ordered list 
2. item 2 
    i) sub-item 1 
         A.  sub-sub-item 1 

(@)  A list whose numbering 

continues after 

(@)  an interruption 

Term 1 

:   Definition 1 

| Right | Left | Default | Center | 
|------:|:-----|---------|:------:| 
|   12  |  12  |    12   |    12  | 
|  123  |  123 |   123   |   123  | 
|    1  |    1 |     1   |     1  | 

- slide bullet 1 
- slide bullet 2   

(>- to have bullets appear on click) 

horizontal rule/slide break:  

*** 

A footnote [^1] 

[^1]: Here is the footnote. 

Write with syntax on the left to create effect on right (after render)
Pandoc’s Markdown Set render options with YAML

When you render, R Markdown  
1. runs the R code, embeds results and text into .md file with knitr  
2. then converts the .md file into the finished format with pandoc

Create a Reusable Template
1. Create a new package with a inst/rmarkdown/templates 
directory 
2. In the directory, Place a folder that contains: 
template.yaml (see below) 
skeleton.Rmd (contents of the template) 
any supporting files 
3. Install the package 
4. Access template in wizard at File ▶ New File ▶ R Markdown  
template.yaml

rmarkdown

Set a document’s 
default output format 
in the YAML header:

--- 
output: html_document 
--- 
# Body

output value creates
html_document html
pdf_document pdf (requires Tex )
word_document Microsoft Word (.docx)
odt_document OpenDocument Text
rtf_document Rich Text Format
md_document Markdown
github_document Github compatible markdown
ioslides_presentation ioslides HTML slides
slidy_presentation slidy HTML slides
beamer_presentation Beamer pdf slides (requires Tex)

Customize output with 
sub-options (listed to 
the right):

--- 
output: html_document: 
  code_folding: hide 
  toc_float: TRUE 
--- 
# Body

Indent 4 
spaces

Indent 2 
spaces

html tabsets 
Use tablet css class to place sub-headers into tabs

# Tabset {.tabset .tabset-fade .tabset-pills} 
## Tab 1 
text 1 
## Tab 2 
text 2 
### End tabset

Tabset 

text 1 
End tabset

  Tab 1   Tab 2

--- 
name: My Template 
—

sub-option description
citation_package The LaTeX package to process citations, natbib, biblatex or none X X X
code_folding Let readers to toggle the display of R code, "none", "hide", or "show" X
colortheme Beamer color theme to use X
css CSS file to use to style document X X X
dev Graphics device to use for figure output (e.g. "png") X X X X X X X
duration Add a countdown timer (in minutes) to footer of slides X
fig_caption Should figures be rendered with captions? X X X X X X X
fig_height, fig_width Default figure height and width  (in inches) for document X X X X X X X X X X
highlight Syntax highlighting: "tango", "pygments", "kate","zenburn", "textmate" X X X X X
includes File of content to place in document (in_header, before_body, after_body) X X X X X X X X
incremental Should bullets appear one at a time (on presenter mouse clicks)? X X X
keep_md Save a copy of .md file that contains knitr output X X X X X X
keep_tex Save a copy of .tex file that contains knitr output X X
latex_engine Engine to render latex, "pdflatex", "xelatex", or "lualatex" X X
lib_dir Directory of dependency files to use (Bootstrap, MathJax, etc.) X X X
mathjax Set to local or a URL to use a local/URL version of MathJax to render equations X X X
md_extensions Markdown extensions to add to default definition or R Markdown X X X X X X X X X X
number_sections Add section numbering to headers X X
pandoc_args Additional arguments to pass to Pandoc X X X X X X X X X X
preserve_yaml Preserve YAML front matter in final document? X
reference_docx docx file whose styles should be copied when producing docx output X
self_contained Embed dependencies into the doc X X X
slide_level The lowest heading level that defines individual slides X
smaller Use the smaller font size in the presentation? X
smart Convert straight quotes to curly, dashes to em-dashes, … to ellipses, etc. X X X
template Pandoc template to use when rendering file quarterly_report.html). X X X X X
theme Bootswatch or Beamer theme to use for page X X
toc Add a table of contents at start of document X X X X X X X
toc_depth The lowest level of headings to add to table of contents X X X X X X
toc_float Float the table of contents to the left of the main content X
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Table Suggestions Citations and Bibliographies
Several functions format R data into tables

Learn more in  
the stargazer, 

xtable, and knitr 
packages.

Create citations with .bib, .bibtex, .copac, .enl, .json,  
.medline, .mods, .ris, .wos, and .xml files 

1. Set bibliography file and CSL 1.0  
Style file (optional) in the YAML header 

2.  Use citation keys in text 

3.  Render. Bibliography will be  
added to end of document

Smith cited [@smith04]. 
Smith cited without author [-@smith04]. 
@smith04 cited in line.

--- 
bibliography: refs.bib  
csl: style.csl 
---

data <- faithful[1:4, ]

RStudio® is a trademark of RStudio, Inc.  •  CC BY SA  RStudio •  info@rstudio.com  •  844-448-1212 • rstudio.com •  Learn more at rmarkdown.rstudio.com  •  rmarkdown  1.6  •  Updated: 2016-02

https://creativecommons.org/licenses/by-sa/4.0/
mailto:info@rstudio.com
http://rstudio.com


Base R  
Cheat Sheet 
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Input Ouput Description 

df <- read.table(‘file.txt’) write.table(df, ‘file.txt’) Read and write a delimited text 
file.

df <- read.csv(‘file.csv’) write.csv(df, ‘file.csv’)

Read and write a comma 
separated value file. This is a 

special case of read.table/
write.table. 

load(‘file.RData’) save(df, file = ’file.Rdata’) Read and write an R data file, a 
file type special for R. 

?mean  
Get help of a particular function. 
help.search(‘weighted mean’) 
Search the help files for a word or phrase. 
help(package = ‘dplyr’) 
Find help for a package. 

Getting Help
Accessing the help files

More about an object

str(iris) 
Get a summary of an object’s structure.  
class(iris) 
Find the class an object belongs to.

Programming
For Loop

for (variable in sequence){ 

Do something 

}

Example
for (i in 1:4){ 

j <- i + 10 

print(j) 

}

While Loop

while (condition){ 

Do something 

}

Example
while (i < 5){ 

print(i) 

i <- i + 1 

}

If Statements

if (condition){ 
Do something 

} else { 
Do something different  

}

Example
if (i > 3){ 

print(‘Yes’) 
} else { 

print(‘No’)  
}

Functions
function_name <- function(var){ 

Do something 

return(new_variable) 
}

Example
square <- function(x){ 

squared <- x*x 

return(squared) 
}

a == b Are equal a > b Greater than a >= b Greater than 
or equal to is.na(a) Is missing

a != b Not equal a < b Less than a <= b Less than or 
equal to

is.null(a) Is null 
Conditions

Creating Vectors

c(2, 4, 6) 2 4 6 Join elements into 
a vector 

2:6 2 3 4 5 6 An integer 
sequence

seq(2, 3, by=0.5) 2.0 2.5 3.0 A complex 
sequence

rep(1:2, times=3) 1 2 1 2 1 2 Repeat a vector

rep(1:2, each=3) 1 1 1 2 2 2 Repeat elements 
of a vector 

install.packages(‘dplyr’) 
Download and install a package from CRAN. 

library(dplyr)  
Load the package into the session, making all 
its functions available to use.  

dplyr::select  
Use a particular function from a package. 

data(iris) 
Load a built-in dataset into the environment. 

Using Packages

Vectors

Selecting Vector Elements 

x[4] The fourth element.

x[-4] All but the fourth.

x[2:4] Elements two to four.

x[-(2:4)] All elements except 
two to four.

x[c(1, 5)] Elements one and 
five.

x[x == 10] Elements which 
are equal to 10.

x[x < 0] All elements less 
than zero.

x[x %in%  
c(1, 2, 5)]

Elements in the set 
1, 2, 5.

By Position

By Value

Named Vectors 

x[‘apple’] Element with 
name ‘apple’.

Reading and Writing Data

Working Directory
getwd() 
Find the current working directory (where 
inputs are found and outputs are sent). 

setwd(‘C://file/path’) 
Change the current working directory. 

Use projects in RStudio to set the working  
directory to the folder you are working in.  

Vector Functions
sort(x)  
Return x sorted.

rev(x)  
Return x reversed.

table(x)  
See counts of values.

unique(x)  
See unique values.

Also see the readr package.
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Lists

Matrices

Data Frames

Maths Functions 

Types Strings 

Factors 

Statistics 

Distributions 

as.logical TRUE, FALSE, TRUE Boolean values (TRUE or FALSE).

as.numeric 1, 0, 1 Integers or floating point 
numbers.

as.character '1', '0', '1' Character strings. Generally 
preferred to factors.

as.factor
'1', '0', '1', 
levels: '1', '0'

Character strings with preset 
levels. Needed for some 

statistical models. 

Converting between common data types in R. Can always go 
from a higher value in the table to a lower value. 

> a <- 'apple' 
> a 
[1] 'apple'

The Environment

Variable Assignment

ls() List all variables in the 
environment.

rm(x) Remove x from the 
environment.

rm(list = ls()) Remove all variables from the 
environment.

You can use the environment panel in RStudio to 
browse variables in your environment. 

factor(x) 
Turn a vector into a factor. Can 
set the levels of the factor and 

the order.

m <- matrix(x, nrow = 3, ncol = 3) 
 Create a matrix from x.

wwwwww
m[2,  ] - Select a row

m[ , 1] - Select a  column

m[2, 3] -  Select an elementwwwwww
wwwwww

t(m) 
Transpose 
m %*% n 

Matrix Multiplication 
solve(m, n) 

Find x in: m * x = n

l <- list(x = 1:5, y = c('a', 'b')) 
 A list is a collection of elements which can be of different types. 

l[[2]] l[1] l$x l['y']

Second element 
of l.

New list with 
only the first 

element.

Element named 
x.

New list with 
only element 

named y.

df <- data.frame(x = 1:3, y = c('a', 'b', 'c')) 
A special case of a list where all elements are the same length.

t.test(x, y) 
Perform a t-test for 
difference between 

means. 

pairwise.t.test 
 Perform a t-test for 

 paired data.

log(x) Natural log. sum(x) Sum.

exp(x) Exponential. mean(x) Mean.

max(x) Largest element. median(x) Median. 

min(x) Smallest element. quantile(x) Percentage 
quantiles.

round(x, n) Round to n decimal 
places.

rank(x) Rank of elements.

signif(x, n) Round to n 
significant figures.

var(x) The variance.

cor(x, y) Correlation. sd(x) The standard 
deviation.

x y

1 a

2 b

3 c

Matrix subsetting

df[2, ]

df[ , 2]

df[2, 2]

List subsetting

df$x df[[2]]

cbind - Bind columns.

rbind - Bind rows.

View(df) See the full data 
frame.

head(df) See the first 6 
rows.

Understanding a data frame

nrow(df) 
Number of rows. 

ncol(df) 
Number of 
columns. 

dim(df) 
Number of 
columns and 
rows.

Plotting  

Dates See the lubridate package.

Also see the ggplot2 package.

Also see the stringr package.

Also see the 
dplyr package.

plot(x) 
Values of x in 

order.

plot(x, y) 
Values of x 
against y.

hist(x) 
Histogram of 

x.

Random 
Variates 

Density 
Function

Cumulative 
Distribution

Quantile

Normal rnorm dnorm pnorm qnorm

Poisson rpois dpois ppois qpois

Binomial rbinom dbinom pbinom qbinom

Uniform runif dunif punif qunif

lm(y ~ x, data=df) 
Linear model. 

glm(y ~ x, data=df) 
Generalised linear model. 

summary 
Get more detailed information 

 out a model.

prop.test 
Test for a 
difference 
between 

proportions. 

aov 
Analysis of 
variance. 

paste(x, y, sep = ' ') Join multiple vectors together.

paste(x, collapse = ' ') Join elements of a vector together.

grep(pattern, x) Find regular expression matches in x. 

gsub(pattern, replace, x) Replace matches in x with a string.

toupper(x) Convert to uppercase.

tolower(x) Convert to lowercase.

nchar(x) Number of characters in a string. 

cut(x, breaks = 4) 
Turn a numeric vector into a 

factor by ‘cutting’ into 
sections.  
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* Matches at least 0 times 

+ Matches at least 1 time 

? Matches at most 1 time; optional string 

{n} Matches exactly n times 

{n,} Matches at least n times 

{,n} Matches at most n times 

{n,m} Matches between n and m times 

> string <- c("Hiphopopotamus", "Rhymenoceros", "time for bottomless lyrics")  
> pattern <- "t.m"  

grep(pattern, string) 
[1] 1 3 

grep(pattern, string, value = TRUE) 
[1] "Hiphopopotamus"  
[2] "time for bottomless lyrics“ 

grepl(pattern, string) 

[1]  TRUE FALSE  TRUE 

stringr::str_detect(string, pattern) 
[1]  TRUE FALSE  TRUE 

regexpr(pattern, string) 

find starting position and length of first match  

gregexpr(pattern, string) 

find starting position and length of all matches  

stringr::str_locate(string, pattern) 

find starting and end position of first match  

stringr::str_locate_all(string, pattern) 

find starting and end position of all matches  

regmatches(string, regexpr(pattern, string))   

extract first match [1] "tam" "tim"  

regmatches(string, gregexpr(pattern, string)) 

extracts all matches, outputs a list  
[[1]] "tam" [[2]] character(0) [[3]] "tim" "tom" 

stringr::str_extract(string, pattern) 

extract first match [1] "tam" NA  "tim"  

stringr::str_extract_all(string, pattern) 

extract all matches, outputs a list  

stringr::str_extract_all(string, pattern, simplify = TRUE) 

extract all matches, outputs a matrix 

stringr::str_match(string, pattern) 

extract first match + individual character groups  

stringr::str_match_all(string, pattern) 

extract all matches + individual character groups  

sub(pattern, replacement, string) 

replace first match 

gsub(pattern, replacement, string) 

replace all matches 

stringr::str_replace(string, pattern, replacement) 

replace first match 

stringr::str_replace_all(string, pattern, replacement) 

replace all matches strsplit(string, pattern) or stringr::str_split(string, pattern) 

pattern 

    string 

^ Start of the string 

$ End of the string 

\\b Empty string at either edge of a word 

\\B NOT the edge of a word 

\\< Beginning of a word 

\\> End of a word 

[[:digit:]] or \\d Digits; [0-9] 

\\D Non-digits; [^0-9] 

[[:lower:]] Lower-case letters; [a-z] 

[[:upper:]] Upper-case letters; [A-Z] 

[[:alpha:]] Alphabetic characters; [A-z] 

[[:alnum:]] Alphanumeric characters [A-z0-9] 

\\w Word characters; [A-z0-9_] 

\\W Non-word characters 

[[:xdigit:]] or \\x Hexadec. digits; [0-9A-Fa-f] 

[[:blank:]] Space and tab 

[[:space:]] or \\s 

 

Space, tab, vertical tab, newline, 

form feed, carriage return 

\\S Not space; [^[:space:]] 

[[:punct:]] 

 
Punctuation characters; 
!"#$%&’()*+,-./:;<=>?@[]^_`{|}~ 

[[:graph:]] 
Graphical char.; 
[[:alnum:][:punct:]] 

[[:print:]] 
Printable characters; 
[[:alnum:][:punct:]\\s] 

[[:cntrl:]] or \\c Control characters; \n, \r etc. 

. Any character except \n 

| Or, e.g. (a|b) 

[…] List permitted characters, e.g. [abc] 

[a-z] Specify character ranges 

[^…] List excluded characters 

(…) 

 

Grouping, enables back referencing using 
\\N where N is an integer 

\n New line 

\r Carriage return 

\t Tab 

\v Vertical tab 

\f Form feed 

(?=) 

 
Lookahead (requires PERL = TRUE), 

e.g. (?=yx): position followed by 'xy' 

(?!) 

 
Negative lookahead (PERL = TRUE); 

position NOT followed by pattern 

(?<=) 

 
Lookbehind (PERL = TRUE), e.g. 

(?<=yx): position following 'xy' 

(?<!) 

Negative lookbehind (PERL = TRUE); 

position NOT following pattern 

?(if)then 

 
If-then-condition (PERL = TRUE); use 

lookaheads, optional char. etc in if-clause 

?(if)then|else If-then-else-condition (PERL = TRUE) 

*see, e.g.  http://www.regular-expressions.info/lookaround.html 

 http://www.regular-expressions.info/conditional.html 

By default R uses POSIX extended regular  

expressions. You can switch to PCRE regular  

expressions using PERL = TRUE for base or by  

wrapping patterns with perl() for stringr. 

All functions can be used with literal searches  

using fixed = TRUE for base or by wrapping  

patterns with fixed() for stringr. 

All base functions can be made case insensitive 

by specifying ignore.cases = TRUE. 

Metacharacters (. * + etc.) can be used as  

literal characters by escaping them. Characters  

can be escaped using \\ or by enclosing them  

in \\Q...\\E. 

By default the asterisk * is greedy, i.e. it always 

matches the longest possible string. It can be  

used in lazy mode by adding ?, i.e. *?. 

Greedy mode can be turned off using (?U). This 

switches the syntax, so that (?U)a* is lazy and 

(?U)a*? is greedy. 
Regular expressions can be made case insensitive 

using (?i). In backreferences, the strings can be  

converted to lower or upper case using \\L or \\U 

(e.g. \\L\\1). This requires PERL = TRUE. 
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Regular expressions can conveniently be  

created using rex::rex(). 
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